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Abstract

These Application Notes describe the steps to configure Session Initiation Protocol (SIP)
Trunking for an enterprise solution using Avaya IP Office 10.0 and Avaya Session Border
Controller for Enterprise 7.1 to interoperate with the Ironton SIP Trunking Service.

The Ironton SIP Trunking Service provides PSTN access via a SIP trunk between the
enterprise and the Ironton network as an alternative to legacy analog or digital trunks. This
approach generally results in lower cost for the enterprise. Ironton is a member of the Avaya
DevConnect Service Provider program.

Readers should pay attention to Section 2, in particular the scope of testing as outlined in
Section 2.1 as well as the observations noted in Section 2.2, to ensure that their own use cases
are adequately covered by this scope and results.

Information in these Application Notes has been obtained through DevConnect compliance
testing and additional technical discussions. Testing was conducted via the DevConnect
Program at the Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the steps to configure Session Initiation Protocol (SIP)
Trunking for an enterprise solution using Avaya IP Office 10.0 and the Avaya Session Border
Controller for Enterprise 7.1 (Avaya SBCE) to interoperate with the Ironton SIP Trunking
Service.

The Ironton SIP Trunking Service will enable delivery of origination and termination of local,
long-distance and toll-free traffic across a single broadband connection. A SIP signaling
interface will be enabled to the Customer Premises Equipment (CPE).

2. General Test Approach and Test Results

The general test approach was to connect a simulated enterprise site via the public Internet and
exercise the features and functionality listed in Section 2.1. The simulated enterprise site was
comprised of Avaya IP Office, Avaya SBCE and various Avaya endpoints listed in Section 4.

The Ironton SIP Trunking Service passed compliance testing with any observations or limitations
described in Section 2.2.

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent
to the interoperability of the tested products and their functionalities. DevConnect Compliance
Testing is not intended to substitute full product performance or feature testing performed by
DevConnect members, nor is it to be construed as an endorsement by Avaya of the suitability or
completeness of a DevConnect member’s solution.

2.1. Interoperability Compliance Testing

To verify SIP trunking interoperability, the following features and functionality were covered
during the interoperability compliance test:

e Establishment and registration of the SIP trunk

e SIP OPTIONS queries and responses

e Incoming PSTN calls (via the Ironton SIP trunk) to SIP and H.323 telephones at the
enterprise

e Qutgoing PSTN calls (via the Ironton SIP trunk) from SIP and H.323 telephones at the
enterprise

e Inbound and outbound PSTN calls to/from Avaya Communicator for Windows and
Avaya Communicator for Web

e Various call types including: local, long distance, outbound toll-free, international (011 +

country code + number) and local directory assistance (411)

Codecs G.711MU and G.729A

Caller ID presentation and Caller ID restriction

DTMF transmission using RFC 2833

Response to incomplete call attempts and trunk errors
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Voicemail navigation using DTMF input for inbound and outbound calls

Voicemail message waiting indicator (MW1)

User features such as hold and resume, internal call forwarding, transfer, and conference
Off-net call forwarding and twinning (mobility)

T.38 and G.711 fax

Remote worker

Emergency calls (911) and inbound toll-free calls are supported but were not tested as part of
the compliance test.

The following items are not supported:

Operator (0) and operator assisted (0 + 10 digits) calls
Real-time control protocol (RTCP) messages

2.2. Test Results

Interoperability testing of the Ironton SIP Trunking Service was completed with successful
results for all test cases with the exception of the observations/limitations described below.

Ironton returns “501 Unsupported” to OPTIONS: Ironton returns a “501
Unsupported” response instead of a 200 OK response to OPTIONS messages sent by
Avaya IP Office. Avaya IP Office still accepts this as an indication that the trunk is in
service. No unfavorable user impact is caused by this behavior.

Ironton sends the pilot number in the Request URI: Ironton sends the pilot number in
the Request URI and the destination number in the To header. Thus, Avaya IP Office
must be configured to route on the To header (Section 5.4.8).

Media may be transmitted to/from an IP address other than the one where Avaya IP
Office is registered: If Avaya IP Office resides behind a firewall, the firewall will need
to be configured to allow media from any additional IP addresses as identified by Ironton.
Authentication: If the outbound INVITE message sent from the enterprise is challenged
by Ironton, then the enterprise will resend the INVITE with credentials but with a new
Call-ID instead of the existing Call-1D. This makes the call appear as a new call. This
behavior had no user impact. It is believed to be an Avaya SBCE issue. It is believed that
this behavior may also impact outbound REFER messages sent by the enterprise if they
are challenged. However, during the compliance test, no REFER messages from the
enterprise were challenged by Ironton.

REFER and transfer before answer: When an Avaya IP Office H.323 phone performs
a “transfer before answer” of an active call to a PSTN destination and REFER is enabled,
a REFER message is sent to Ironton before both call legs have sent/received a 200 OK.
Ironton does not support this call flow and rejects the REFER with a 400 “Transfer to not
connected leg” error. With Avaya IP Office 9.1, this call flow resulted in a successful
transfer but the trunk resources on Avaya IP Office were not released until the call was
complete. With Avaya IP Office 10.0, the call was successfully transferred and trunk
resources were properly released.
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e Directory Assistance: Local directory assistance calls did not work in the lab
environment which was believed to be due to a routing issue. This problem is not
expected to be present in the production environment.

2.3. Support

For technical support on the Ironton SIP Trunking Service, please contact Ironton Telephone
Company via the following:

e Web: http://www.ironton.com
e Phone: 1-610-799-3131

Avaya customers may obtain documentation and support for Avaya products by visiting
http://support.avaya.com. Alternatively, in the United States, (866) GO-AVAYA (866-462-8292)
provides access to overall sales and service support menus.
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3. Reference Configuration

Figure 1 illustrates the sample configuration used for the DevConnect compliance testing. The
sample configuration shows an enterprise site connected to the Ironton SIP Trunking Service.

Located at the enterprise is the Avaya SBCE. It has a public side that connects to the Ironton SIP
Trunking Service. The private side of the Avaya SBCE connects to the enterprise network. All
SIP and RTP traffic entering or leaving the enterprise flows through the Avaya SBCE. In this
way, the Avaya SBCE can protect the enterprise against any SIP-based attacks. The Avaya
SBCE provides network address translation at both the IP and SIP layers.

The enterprise site contains an Avaya IP Office 500 V2 with various endpoints and a Windows
PC running both Avaya IP Office Manager to configure Avaya IP Office and Avaya VoiceMail
Pro for voicemail. In addition, the Avaya IP Office Application Server is present to support use
of Avaya Communicator for Web (WebRTC client).
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Figure 1: Avaya Interoperability Test Lab Configuration
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For security purposes, any public IP addresses or PSTN routable phone numbers used in the
compliance test are not shown in these Application Notes. Instead, public IP addresses have
been replaced with private addresses and all phone numbers have been replaced with numbers
that cannot be routed over the PSTN.

For the purposes of the compliance test, users dialed a prefix digit 9 plus N digits to send an
outbound call to the number N across the SIP trunk to the service provider. The short code of 9
was stripped off by Avaya IP Office and the remaining N digits were sent to the service provider
network. For calls within the North American Numbering Plan (NANP), the user dialed 11 (1 +
10) digits for long distance and local calls. Thus, for these NANP calls, Avaya IP Office sent 11
digits in the Request URI and the To header of an outbound SIP INVITE message.

Ironton sends a fixed 11 digit billing/pilot number in the Request-URI and the 11 digit
destination number in the To header. As a result, Avaya IP Office was configured to route the
call based on the To header (Section 5.4.8).

In an actual customer configuration, the enterprise site may also include additional network
components between the service provider and the enterprise network such as a data firewall. A
complete discussion of the configuration of these devices is beyond the scope of these
Application Notes. However, it should be noted that SIP and RTP traffic between the service
provider and Avaya IP Office must be allowed to pass through these devices.

The administration of the Avaya Voicemail Pro messaging service and endpoints on Avaya IP
Office are standard. Since these configuration tasks are not directly related to the inter-operation
with the Ironton SIP Trunking Service, they are not included in these Application Notes.
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4. Equipment and Software Validated
The following equipment and software were used for the sample configuration provided:

Avaya Telephony Components

Equipment Software

Avaya IP Office 500 v2 10.0 (10.0.0.0.0 Build 550)
Avaya IP Office Manager 10.0 (10.0.0.0.0 Build 550)
Avaya IP Office VoiceMail Pro 10.0 (10.0.0.0.0 Build 469)
Avaya IP Office Application Server

e 0ne-X® Portal 10.0 (10.0.0.0.0 Build 980)

e WebRTC Gateway 10.0 (10.0.0.0.0 Build 140)
Avaya Session Border Controller for 7.1
Enterprise running on a Portwell CAD-0208 (7.1.0.0-04-11122)
server
Avaya 1140E IP Deskphone (SIP) 4.4 SP2 (4.04.18)
Avaya 1616 IP Deskphone (H.323) running 1.3.5(1.3.50B)
Avaya one-X® Deskphone Value Edition
Avaya 9641G IP Deskphone (H.323) running 6.6.2 (6.6229)
Avaya one-X® Deskphone Edition
Avaya Communicator for Windows 2.1.3(2.1.3.237)
Avaya Communicator for Web 1.0.16.1718

Ironton Components
Equipment Software

PortaOne PortaSwitch MR50

Compliance Testing is applicable when the tested solution is deployed with a standalone IP
Office 500 V2 and also when deployed with IP Office Server Edition in all configurations.

Avaya IP Office Server Edition requires an Expansion IP Office 500 V2 to support analog/digital
endpoints or analog/digital trunks.
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5. Configure Avaya IP Office

Avaya IP Office is configured through the Avaya IP Office Manager PC application. From the
Avaya IP Office Manager PC, select Start - All Programs - IP Office - Manager to launch
the application. A screen that includes the following may be displayed:

WELCOME to IP Office Administration

What would you like to do ?

Create an Offline Configuration

Oipen Configuration from System

Fead a Configuration from File

Select Open Configuration from System. If the above screen does not appear, the
configuration may be alternatively opened by navigating to File > Open Configuration at the
top of the Avaya IP Office Manager window. Select the proper Avaya IP Office system from the
pop-up window and log in with the appropriate credentials.

The appearance of the IP Office Manager can be customized using the View menu. In the
screens presented in this document, the View menu was configured to show the Navigation pane
on the left side, omit the Group pane in the center, and show the Details pane on the right side.
Since the Group Pane has been omitted, its content is shown as submenus in the Navigation
pane. The Navigation and Details panes will be referenced throughout the Avaya IP Office
configuration. All licensing and feature configuration that is not directly related to the interface
with the service provider (such as twinning and Avaya Communicator support) is assumed to
already be in place.

In the sample configuration, Atlantic City was used as the system name. All navigation
described in the following sections (e.g., License > SIP Trunk Channels) appears as submenus
underneath the system name Atlantic City in the Navigation Pane.
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5.1. Licensing and Physical Hardware

The configuration and features described in these Application Notes require Avaya IP Office to
be licensed appropriately. If a desired feature is not enabled or there is insufficient capacity,
contact an authorized Avaya sales representative.

To verify that there is a SIP Trunk Channels License with sufficient capacity; click License in
the Navigation pane. Confirm a valid license with sufficient Instances (trunk channels) appears

in the Details pane.

IP Offices |

v | < | >
- R BOOTP (3) License  Remote Server
[#-4# Operator (3)
-5 Atlantic City License Mode License Normal
g}“{ E?:Ze(r;sgm Licensed Version 10.0
-2 Control Unit (3) PLDS Host ID
[ Extension (23) . ’
D___a User (27) PLDS File Status  Valid
-5 Group (1)
Dg EZrD\rrch?[?)e (63) Feature Key Instances Status 2 Add...
D...@ RAS (1) Receptionist /A 4 Valid
E]---@ Inceming Call Route Additional Voicemail Pro Ports MN/A 152 Valid Remove
""" €2 WAN Port (0) VMPro Recordings Administrators N/A 1 Valid
::::? ?ii:;t;gél[’i o Essential Edition Additional Voice..  N/A 4 Valid
EJ@ Firewall Profile (1) VMPro TTS (Generic) MN/A 40 Valfd
w=-Jill 1P Route (4) Teleworker MN/A 384 Valid
----- & Account Code (0) Mobile Worker MN/A 384 Valid
----- L Y License (104)] Office Worker N/A 384 Valid
""" e Tunne.l 0 Avaya Softphone Licence N/A 100 Valid
gn‘(' i;‘;’ 3'39)”5 @ VMPro TTS (Scansoft) N/A 0 Valid
_____ i Location (0) VMPro TTS Professional MN/A 40 Valid
..... 2% Authorization Code ( IPSec Tunnelling M/A 1 Valid
Power User N/A 384 Valid
Avaya IP endpoints N/A 384 Valid
IP300 Voice Metworking Channels  N/A 32 Valid
SIP Trunk Channels N/A 128 Valid
IP500 Universal PRI (Additional cha... N/A 100 Valid
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To view the physical hardware comprising Avaya IP Office, expand the components under the
Control Unit in the Navigation pane. In the sample configuration, the second component listed
is a Combination Card. This module has 6 digital stations ports, two analog extension ports, 4
analog trunk ports and 10 VCM channels. The VCM is a Voice Compression Module supporting
VoIP codecs. An Avaya IP Office hardware configuration with a VCM component is necessary
to support SIP trunking.

To view the details of the component, select the component in the Navigation pane. The
following screen shows the details of the IP 500 V2.

IP Offices = IP 500 V2 (B v | <>
=- R BOOTP (3) Unit
-4 Operator (3)
-3 Atlantic City Device Mumber |'|
t-%%7 System (1) .
-7 Line (25) Unit Type [IP 500 v2
== Control Unit (3) ) :
[ 1 1P 500 V2 Version |'|'D.'D.0.0.0 build 530
= 3 DIGSTAS/ATMA Serial Number

H-48 Bxtension (23)

|
|
|
= 2 COMBOG210/ATM4 | |
|
|
|

E .
10.32,128.25
EJ"'a User 27) Unit IP Address |
-5 Group (1) Interconnect Number |0
@) Short Code (63)
""" B service (0) Module Number |C0r1tr0| Unit
oy RAS (1)
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5.2. System
Configure the necessary system settings.

5.2.1. System — LAN1 Tab

In the sample configuration, the Avaya IP Office LAN port was used to connect to the enterprise
network. The LANL1 settings correspond to the LAN port on the Avaya IP Office 500 V2. To
access the LANL settings, first navigate to System - <Name>, where <Name> is the system
name assigned to the Avaya IP Office. In the case of the compliance test, the system name is
Atlantic City. Next, navigate to the LAN1 - LAN Settings tab in the Details Pane. Set the IP
Address field to the IP address assigned to the Avaya IP Office LAN port. Set the IP Mask

field to the mask used on the enterprise network. All other parameters should be set according to
customer requirements.

IP Offices |E Atlantic City e v <>

2-R BOOTP (3)
.é_....;,‘. Operator (3)

SMDR - VCM - VelP YolP Security Contact Center

;"':.““' Atlantic City System LANT  [AN2  DNS Voicemail Telephony Directory Services  System Events  SMTP
System (1 LAN Settings  olP Metwork Topology
-1 Line (25) IP Address v .32 BB
42 Control Unit (3)
+-4 Extension (25) IP Mask 255 . 255 . 255 0
w-§  User (27)
+ﬂ Group (1) Primary Trans. P Address ] ] 0 i]
+-8% Short Code (65)
@ Service (0) RIP Mode Mone k4
=-ns RAS (1) ] Enable NAT

+® Inceming Call Route (76)
-0 WAN Port (0)
o= Directory (0)
I Time Profile (0) DHCP Maode
-8} Firewall Profile (1)

Mumber Of DHCP IP Addresses 200 2

-l P Route (4 () Server () Client () Dialln (@) Disabled Advanced
- Account Code (0)
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On the VolIP tab in the Details Pane configure the following parameters:

e Check the SIP Trunks Enable box to enable the configuration of SIP trunks.

e The RTP Port Number Range can be customized to a specific range of ports that Avaya
IP Office will use for RTP media. This port range will be used to select a destination port
for incoming RTP and a source port for outgoing RTP for calls using LAN1.

H—

= Atlantic City ) v | < |

Contact Center

System LANT  LANZ  DNS Voicemail Telephony Directory Services  System Events SMTP SMDR VCM - VolP VolP Security
LAN Settings VelP Network Topology

A
H.323 Gatekeeper Enable
[] Auto-create Extension Auto-create User H.323 Remote Extension Enable
H.323 Signaling over TLS Disabled ~ Remote Call Signaling Port 1720 2

SIP Trunks Enable
SIP Registrar Enable

[ Auto-create Extension/User SIP Remote Extension Enable

5IP Domain Name | |

SIP Registrar FQDN | |

upP UDP Port 3060 5 Remote UDP Port (5060 5
Layer 4 Protocol TCP TCP Port 3060 = Rernote TCP Port 3060 =
D TLS TLS Port | 3061 = Remote TLS Port 3061 =
Challenge Expiration Time (sec) 10 =
RTP
Port Mumber Range
Minimum 49132 = Maximum 53246 =
Port NMumber Range (NAT)
Minimum 49152 o Maximum 53246 o
L¥]
CTM; Reviewed: Solution & Interoperability Test Lab Application Notes 12 of 72

SPOC 11/9/2016 ©2016 Avaya Inc. All Rights Reserved. IronlPO10SBCE71



Scroll down the page.

e Inthe Keepalives section, set the Scope to RTP. Ironton does not support RTCP. Set
the periodic timeout to 30 and the Initial keepalives parameter to Enabled. These
settings will cause Avaya IP Office to send a RTP keepalive packet starting at the time of
initial connection and every 30 seconds thereafter if no other RTP traffic is present. This
facilitates the flow of media in cases where each end of the connection is waiting to see
media from the other, as well as helping to keep firewall ports open for the duration of

the call.

e Inthe DiffServ Settings section, Avaya IP Office can also be configured to mark the
Differentiated Services Code Point (DSCP) in the IP header with specific values to
support Quality of Services policies for both signaling and media. The DSCP field is the
value used for media and the SIG DSCP is the value used for signaling. The specific
values used for the compliance test were the Avaya IP Office default values and are
shown in the screenshot below. Quality of Service (QoS) is not specifically tested as part
of the compliance test. These DSCP values defined for LAN1 are used within the
enterprise and not sent to the service provider.

e All other parameters should be set according to customer requirements.

x

= Atlantic City

Contact Center

System | LANL |LAN2 | DNS | Voicemail | Telephony | Directory Services | System Events | SMTP | SMDR | Twinning | VCM | Codecs | VolP Security

LAN Settings | VoIP | Network Topology|
Enable RTCP Menitoring on Pert 5005
RTCP cellector IP address for phones 0 0 0 0
Keepalives
Scope IRTP vJ Pericdic timeout 30
Initial keepalives IEnabIed VJ
DiffServ Settings
B8 % DSCP(Hex) (B8 = Video DSCP(Hex) FC DSICP Mask (Hex) 88 =| SIG DSCP (Hex)
46 =) Dscp 46 = Video DSCP 63 DSCP Mask 34 2| SIGDSCP
DHCP Settings
Primary Site Specific Option Number (550N) 176 =
Secondary Site Specific Option NMumber (550M) 242 =
VLAN Mot Present hd
1100 Voice VLAN Site Specific Option Number (SSON) 232 =
1100 Voice VLAN IDs

m
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On the Network Topology tab in the Details Pane, configure the following parameters:

e Select the Firewall/NAT Type from the pull-down menu that matches the network
configuration. Since no firewall or network address translation (NAT) device was used
between the Avaya IP Office and the Avaya SBCE, the parameter was set to Open
Internet.

e Set Binding Refresh Time (sec) to 300. This value is used to determine the frequency at
which Avaya IP Office will send SIP OPTIONS messages to the service provider.

e Inthe Public Port section, next to the transport protocol UDP, select the UDP port on
which Avaya IP Office will listen.

e All other parameters should be set according to customer requirements.

i= Atlantic City (i v

Contact Center

Systen LANT  |ANZ  DNS Voicernail Telephony Directory Services  System Events SMTP SMDR VCM - VolP VelP Security
LAN Settings VolP  Metwork Topology

Metwork Topology Discovery

STUMN Server Address 10.90.168.13 STUM Port 3478 =
Firewall/MAT Type Open Internet ~
Binding Refresh Time (sec) 300 =
Public IP Address 0 0 0 0 Run 5TUN Cancel
Public Port

upp 3060 o

TCP 0 5

LS 0 5

[] Run STUN on startup
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5.2.2. System - Telephony Tab

To access the System Telephony settings, navigate to the Telephony - Telephony tab in the
Details Pane. Uncheck the Inhibit Off-Switch Forward/Transfer box to allow call forwarding
and call transfer to the PSTN. If for security reasons incoming calls should not be allowed to
transfer back to the PSTN then leave this setting checked.

= Atlantic City [ v <>

Contact Center

Systemn  LANT  LANZ  DNS Voicemail Telepheny Directory Services System Events SMTP  SMDR  VCM  VolP VolIP Security
Telephony  Park & Page Tones & Music Ring Tones  SM Call Leg TUI

Analogue Extensions Companding Law »
Switch Line
Default Outside Call Sequence Normal ~
Default Inside Call Sequence Ring Type 1 w ® U-Law ® U-Law Line
Default Ring Back Sequence Ring Type 2 ~
A-Law A-Law Line
Restrict Analogue Extension Ringer Voltage [ O ©
Dial Delay Time (sec) 4 = [ DSS Status
= | Auto Hold
Dial Delay Count 0 - oo
. = Dial By Mame
Default Mo Answer Time (sec) 25 S -
) = Show Account Code
Hold Timeout (sec) 0 =
= 7 Inhibit Off-Switch Forward,/ Transfer
Park Timeout (sec) 300 =
= 7 Restrict Metwork Interconnect
Ring Delay (sec) 5 S
- Include location specific information
Call Priority Promotion Time (sec) |Disabled =
[] Drop External Only Impromptu Conference
Default Currency UsD ~
[] Visually Differentiate External Call
Default Name Priority Favor Trunk ~
[] Unsupervised Analog Trunk Disconnect Handling
Media Connection Preservation Disabled ~ . ) )
High Quality Conferencing
Phone Failback Manual e o
Digital/Analogue Aute Create User
Legin Cede Complexity 0
Directory Overrides Barrin
[ Enforcement v d
n - [1 Advertise Callee State To Internal Callers
Complexity
v
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5.3. IP Route

A default route is needed so IP Office can reach other network subnets other than the one where
it resides. Since IP Office and the private side of the Avaya SBCE reside on the same subnet, the
default route is not specifically used for SIP Trunking. Navigate to IP Route - 0.0.0.0 in the
left Navigation Pane if a default route already exists. Otherwise, to create the default route,
right-click on IP Route and select New. Create/verify a default route with the following

parameters:

e Set IP Address and IP Mask to 0.0.0.0.

e Set Gateway IP Address to the IP address of the default router on the network where
Avaya IP Office is connected.

e Set Destination to LAN1 from the drop-down list.

Click the OK button at the bottom of the page (not shown).

+-@% Short Code (65)
@ Service (D)
oy RAS (1)

+© Inceming Call Route (V6)
BB WAN Port (0)

@2 Directory (0)
I Time Profile (0)

- IP Route (4)
n 0.0.0.0

Firewall Profile (1)

[] Proxy ARP

IP Offices |E 0.0.0.0 gf -8 X[ v <>

=& BOOTP (3) IP Route
#-¢# Operator (3)
=15 Atlantic City IP Address 0 0 0

- Systern (1)

¢ s Atlantic City 1P Mask 0 0 ?

19 Line (23) Gateway IP Address 10 32 254

#-2r Control Unit (3)

-4 Extension (23) Destination LAMN1 ~

w-§  User (27)

3% Group (1) Metric 0
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5.4. SIP Line

A SIP line is needed to establish the SIP connection between Avaya IP Office and the Ironton
SIP Trunking Service. The recommended method for configuring a SIP Line is to use the
template associated with these Application Notes. The template is an .xml file that can be used
by IP Office Manager to create a SIP Line. Follow the steps in Section 5.4.1 to create the SIP
Line from the template.

Some items relevant to a specific customer environment are not included in the template or may
need to be updated after the SIP Line is created. Examples include the following:

e |P addresses

e SIP Credentials (if applicable)

e SIP URI entries

e Setting of the Use Network Topology Info field on the Transport tab

Therefore, it is important that the SIP Line configuration be reviewed and updated if necessary
after the SIP Line is created via the template. The resulting SIP Line data can be verified against
the manual configuration shown in Sections 5.4.2 — 5.4.8.

Also, the following SIP Line settings are not supported on Basic Edition:
e SIP Line — Originator number for forwarded and twinning calls

e Transport — Second Explicit DNS Server
e SIP Credentials — Registration Required
e SIP Advanced

e Engineering

To create a SIP Line manually, right-click Line in the Navigation Pane and select New - SIP
Line; then, follow the steps outlined in Sections 5.4.2 — 5.4.8.
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5.4.1. SIP Line From Template

1. Copy the template file to the computer where IP Office Manager is installed. Place it in
an empty directory. This is important because Step 2 will import all templates located in
this directory not just the template file associated with these Application Notes.

2. Import the template into IP Office Manager. From IP Office Manager, select Tools >
Import Templates in Manager. This action will copy all the template files located in
the selected directory into the IP Office template directory and make the templates
available in the IP Office Manager pull-down menus in Step 3.

U™ Avaya IP Office Manager Atlantic City
File Edit VWiew | Tools | Help
8= a E Extension Renumber...
Atlantic City Line Renurnber...
Connect Ta... 1
IP O
Export [ 4
‘!‘ BOOTP (3) S5CM Service User Management Tl
[-i# Operator (3]
EI---’-;- Atlantic City Busy on Held Validation
-5 Systermn (1)
T3 Line (25) M5M Configuration
B2 Control Unit Print Button Labels
L4 Extension (2 5
a User (27) Import Templates in Manager
-8 Group (1) License Migration
=--B% Short Code (B3] |
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In the pop-up window that appears, select the directory where the template file was
copied in Step 1, then click OK.

Browse For Folder X

Select a folder to import templates from -

‘ Desktop
@ Onelrive

a Tester
A This PC
s Libraries
¥ Metwork
»§ Homegroup
[E5] Control Panel

& Recycle Bin

Cancel

After the import is complete, a final import status pop-up window will appear stating
success or failure (not shown). Click OK (not shown) to continue.

Note - Within Avaya IP Office Manager menus, the template directory may be accessed
by navigating to C:\Program Files\Avaya\lP Office\Manager\Templates. However,
the template directory is physically located in the User Access Control Virtual Store area
of Windows. To view the directory from outside Avaya IP Office Manager (e.g.,
Windows Explorer), replace the C: portion of the template path above with
%UserProfile%\AppData\Local\VirtualStore.
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3. To create the SIP Trunk from the template, right-click on Line in the Navigation Pane,
and select New From Template - Open File.

IP Offices = s|
@& BOOTP (3) SIP Line Transport SIP URI VolP  T38 Fax SIP Cf
[-4# Operator (3)
E...:..,.:I, Aﬂant'r”r'ihf Le e 17
i Sy 1] New N
T_‘:ﬁ 1 10.32.12
-2 Cd & Cut Ctrl+X
# Bt 2 Copy Ctrl+C § I:
a Us
u. Gr Paste Ctrl+V SIP
g Shi 2 Delete Ctrl+Del —
hﬂ; RA " Validate
@ Ind Connect Ta... Ctrl+T
#ﬂ W"| Mew from Template 3 " Open from file
e Export as Templat '
L T port as Template
Y Tin o o el ]

4. The subsequent pop-up window opens to C:\Program Files\Avaya\lP
Office\Manager\manager_files\template. Navigate to C:\Program Files\Avaya\lP
Office\Manager\Templates. The up arrow icon can be used to move up through the
directory tree.

T Open x
&« » <« manager_files » template v Search template e
Organize + Mew folder == ~ [N 0
& OneDrive Cad MName Date modified Type
@ This PC Mo items match your search.
[ Desktop
@ Documents
* Downloads
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5. Once reaching the correct directory, select Template Files (.xml) in the lower right

corner to ensure that .xml template files are displayed. From the list of template files,
select the one to be used and click Open.

I Open b
= v « Manager » Templates W) Search Ternplates 2
Organize + Mew folder =~ 1 @
& OneDrive 2 Mame a Date modified Type
_ = IronlPO10SBCET] xml 0/16/2016 4:00 PM XML Docy
 This PC —
[ Desktop
[ Documents
; Downloads
‘b Music
= Pictures
ﬁ Videos
= Local Disk (C:)
oF Metwork
s, Homegroup v < >
File name: |lronlPO10SBCET.xml V| |Temp|ate Files (*.xml) w
A final status pop-up window will appear stating whether the trunk creation was a
success or failure (not shown). Click OK (not shown) to continue.
6. Once the SIP Line is created, verify the configuration of the SIP Line with the
configuration shown in Sections 5.4.2 — 5.4.8.
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5.4.2. SIP Line — SIP Line Tab
On the SIP Line tab in the Details Pane, configure or verify the parameters as shown below.

e Set the ITSP Domain Name to the IP address of the internal signaling interface of the
Avaya SBCE or this field may be left blank. If left blank, Avaya IP Office will
automatically use the ITSP Proxy Address (Section 5.4.3) for this value which is also
set to the IP address of the internal signaling interface of the Avaya SBCE.

e Check the In Service box. This makes the trunk available to incoming and outgoing

calls.

e Check the Check OOS box. Avaya IP Office will use the SIP OPTIONS method to
periodically check the SIP Line. The time between SIP OPTIONS sent by Avaya IP
Office will use the Binding Refresh Time for LAN1, as shown in Section 5.2.1.

e Set the Refresh Method to Re-invite and the Timer (seconds) to 300. This will cause
Avaya IP Office to send an INVITE message every 150 seconds (1/2 the Timer value) to

check the state of each active session.

e Use of REFER should be configured as per the needs of the customer. Call flows with
and without REFER were tested as part of the compliance test. See Section 2.2 for more
details. To enable REFER, set the Incoming Supervised REFER field and Outgoing
Supervised REFER field to Always. To disable REFER, set these fields to Never.

e Default values may be used for all other parameters.

| IPOfices  ||:= SIP Line - Line 17 ef B X[ v <>
- R BOOTP (3) SIP Line Transport SIP URI VolP  T38 Fax SIP Credentials SIP Advanced Engineering
-4 Operator (3)
=150 Atlantic City Line Number 17 In Service
--%52 System (1)
e ITSP Domain Name [1032.128.20 | checkoos

#-<= Control Unit (3)
=4 Extension (25)
=-§  User(27)
+=ﬂ Group (1)
@ Short Code (65)
@B Service (0)
=-di; RAS (1)
&) Incoming Call Route |
8 WAN Port (0
- Directory (0)
£ Time Profile (0)
=@ Firewall Profile (1)
=il IP Route (4)
- Account Code (0)
% License (104)
i Tunnel (0}
=-f3 User Rights (8)
o ARS (13)
B Location (0)
:ﬂ Autherization Code ((

Local Domain Name ‘

URI Type sip

Location Cloud

Prefix \

National Prefix ‘D

International Prefix ‘DD

Country Code ‘

Name Priority System Default

Description ‘

Session Timers
Refresh Method

Timer (sec)

Redirect and Transfer
Incoming Supervised REFER
Outgoing Supervised REFER
Send 302 Moved Temporarily
Outgeing Blind REFER.

Re-invite ~

300

Always ~

Always ~
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5.4.3. SIP Line - Transport Tab
Select the Transport tab. Set or verify the parameters as shown below.

e Setthe ITSP Proxy Address to the IP address of the internal signaling interface of the
Avaya SBCE.

e Set Layer 4 Protocol to UDP.

e Set Use Network Topology Info to the network port used by the SIP line to access the
far-end and configured in Section 5.2.1.

e Set the Send Port to 5060.

e Default values may be used for all other parameters.

= SIP Line - Line 17 gk -8 X | w | <>

SIP Line Transport SIP URI VoIP  T3& Fax SIP Credentials SIP Advanced Engineering

ITSP Proxy Address |10.32.128.20 |

Metwork Configuration

Layer 4 Protocol UDp s Send Port | 3060 =
Use Metwork Topology Info | LAN 1 w 3060 =
Explicit DMNS Server(s) ] ] ] 0 0 ] ] ]

Calls Route via Registrar

Separate Registrar ‘
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5.4.4. SIP Line — SIP Credentials
SIP Credentials are provided by Ironton for registration and authentication of the enterprise. To

enter the SIP Credentials, select the SIP Credentials tab and click Add. In the New SIP
Credentials area that appears, enter the information as shown below.

e Set the User name, Authentication Name, and Contact to the user name provided by
Ironton.

e Set the Password and Confirm Password to the password provided by Ironton.
e Set Expiry (mins) to 60.
e Check the Registration required box.

Click OK.
= SIP Line - Line 17 k- X v <>
SIP Line Transport SIP URI VolP  T38 Fax 5IP Credentials SIP Advanced Engineering
Index User Mame  Authentication Name Contact Expiraticn (mins) Register Add...
Remowve
Edit...

Mew SIP Credentials

User name |16105551234 | 0K
Authentication Mame |'|61 05551234 | Tered
Contact |16105551234 |
Password |uuuu |
Confirm Password |uuuuu" |
Expiration (mins) 60 =
Registration required
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5.4.5. SIP Line - SIP URI Tab

A SIP URI entry must be created to match each incoming number that Avaya IP Office will
accept on this line. Select the SIP URI tab, then click the Add button and the New Channel
area will appear at the bottom of the pane. To edit an existing entry, click an entry in the list at
the top, and click the Edit button. In the example screen below, a new entry is created. The
entry was created with the parameters shown below:

In Avaya IP Office release 10, Local URI, Contact and Display Name are set to Auto
by default. This is equivalent to the wildcard * used in previous releases. For outbound
calls, these settings will populate the user portion of the From and Contact headers with
the DID mapped to the user placing the call. If the user has no DID number, then the
local extension is used which may not be accepted by the service provider. The Avaya IP
Office user name is used for the display name. The Local URI setting also impacts
inbound calls. In this case, no matching is done on the inbound Request-URI, so all calls
are accepted.

Alternatively, to have more administrative control over the contents of these SIP headers,
Local URI, Contact and Display Name may be set to Internal Data. For outbound
calls, these settings will populate the user portion of the From and Contact headers as
well as the display name with the contents of the User - SIP tab (Section 5.7). The
User = SIP tab is only present if a trunk in the system has a SIP URI using Internal
Data. The Local URI setting also impacts inbound calls. In this case, an inbound call is
only accepted if the user portion of the inbound Request-URI matches a value configured
on the system for a user (User = SIP), hunt group (Hunt Group - SIP) or voicemail
(System = Voicemail).

For the compliance test, the default Auto settings were used for most of the testing.
However, some testing was also performed with the Internal Data setting.

Under Identity, set Identity to None. This disables the sending of the P-Asserted
Identity (PAI) and P-Preferred ID (PPI) header in each outbound INVITE. The PAI
header is only sent for privacy and is configured in Section 5.4.8.

Under Forwarding and Twinning, set Send Caller ID to Diversion Header. With this
setting, Avaya IP Office will include the Diversion Header for calls that are forwarded or
directed via Mobile Twinning out the SIP Line. The Diversion Header will contain the
original calling party.

Set Diversion Header to None. This disables the sending of the Diversion header in each
outbound INVITE. The Diversion header is only sent for Forwarding and Twinning as
described above.

For the Registration field, select the SIP credentials configured in Section 5.4.4 from the
pull-down menu.

Associate this line with an incoming line group by entering a line group number in the
Incoming Group field. This line group number will be used in defining incoming call
routes for this line in Section 5.8.1. Similarly, associate the line to an outgoing line
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group using the Outgoing Group field. The outgoing line group number is used in
defining ARS entries for routing outbound traffic to this line in Section 5.5. For the
compliance test, a new incoming and outgoing group 17 was defined that only contained
this line (line 17).

e Set Max Calls per Channel to the number of simultaneous SIP calls that are allowed
using this SIP URI pattern.

Click OK.
7 SIP Line - Line 17 e - X[ v <>
SIP Line Transport SIP URl WolP  T38 Fax SIP Credentials SIP Advanced Engineering
URl Groups Local URI Contact Display.. ldentity Header Originator Mumber Send Caller ID Diversic Add... )
Remove
Edit...
Mew URI oK
Local URI |Auto v
Cancel
Contact |Auto — |
Display Mame |Auto v|
Identity
Identity |N0ne v|
Header P Ascerted D ~

Forwarding And Twinning

Originator

Mumber

send Caller ID Diversion Header v

Diversion Header |Nnr1e -
Registration 1: 16103551234 ~
Incoming Group 17 ~
Outgoing Group 17 ~
Mazx Sessions 10 o

If using Internal Data, additional SIP URIs may be required to allow inbound calls to numbers
not associated with a user, such as a short code. These URIs are created in the same manner as
shown above with the exception that the incoming DID number is entered directly in the Local
URI, Contact, and Display Name fields.
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5.4.6. SIP Line - VoIP Tab

Select the VoI P tab, to set the Voice over Internet Protocol parameters of the SIP line. Set or
verify the parameters as shown below.

For Codec Selection, select System Default from the pull-down menu to use the default
list of codecs. A list of the codecs in their current order of preference will be shown on
the right in the Selected column. To use a custom list of codecs, select Custom for
Codec Selection. Next, move unwanted codecs from the Selected column to the Unused
column. Lastly, move the codecs up or down the list in the Selected column to achieve
the desired order of preference. The example below shows the codecs used for the
compliance test.

Uncheck the VolP Silence Suppression box.

Check the Re-invite Supported box.

Set the Fax Transport Support to T38 Fallback. In general, Ironton supports T.38 fax
but not necessarily on all media gateways in the network. Using the T38 Fallback
setting should allow fax calls to succeed, though some may use G.711 fax instead of
T.38.

Set the DTMF Support field to RFC2833. This directs Avaya IP Office to send DTMF
tones using RTP events messages as defined in RFC2833.

Default values may be used for all other parameters.

7

SIP Line -Line 17 ek - < |

SIP Line Transport SIP URI VelP  T38 Fax SIP Credentials SIP Advanced Engineering

[] volIP Silence Suppression

[] Local Hold Music

Codec Selection System Default > Re-invite Supported

[0 Codec Lockdown

o G.711 ULAW 64K
G.711 ALAW 64K [] Allow Direct Media Path
G.729(a) 8K CS-ACELP
G.723.1 6K3 MP-MLO)
G.722 64K [] PRACK/100rel Supported

Force direct media with phones

[] G.711 Fax ECAN

Fax Transport Support | T38 Fallback ~
DTMF Support RFC2233 v
Media Security Disabled w
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5.4.7. SIP Line —T38 Fax Tab
Select the T38 Fax tab. Leave the Use Default VValues box checked at the bottom of the screen.

7 SIP Line - Line 17 ek - v | < | >

SIP Line Transport SIP URI VolP  T38 Fax SIP Credentials SIP Advanced Engineering

3
Scan Line Fix-up

UDPTL
TFOP Enhancement
= = Disable T30 ECM
- - Disable EFlags For First DIS
’ . Disable T30 MR Compression
Trans TCF NSF Override
14400 0 S
2600 5 0 o
2300 5
150 =
UUse Default Values
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5.4.8. SIP Line — SIP Advanced
Select the SIP Advanced tab. Set the parameters as shown below.

Set Call Routing Method to To Header. Ironton sends the call destination in the To
header and a pilot/billing number in the Request-URI header. Thus, Avaya IP Office was
configured to route on the To header.

Check the Use PAI for Privacy box. If Identity is set to None on the SIP Line = SIP
URI tab, then by default Avaya IP Office will send the P-Preferred-ldentity (PPI) header
when placing a privacy call. Checking this option will cause Avaya IP Office to send the
P-Asserted-Identity (PAI) header instead.

Check the Emulate NOTIFY for REFER box. With REFER enabled, the Avaya 1100
Series Deskphones and Avaya Communicator for Windows expects to receive a NOTIFY
message to indicate that the referred (i.e., transferred) call was successful. If the
NOTIFY is not received from the far-end, then the call display will indicate that the
transfer failed even if the transfer was successful. If the Emulate NOTIFY for REFER
box is checked, then Avaya IP Office will send a NOTIFY message (on behalf of the far-
end) to the Avaya 1100 Series Deskphones and Avaya Communicator for Windows.

Click the OK button at the bottom of the page (not shown).

7 SIP Line - Line 17 ef - <>
SIP Line Transport SIP URI VolP  T38 Fax SIP Credentials 5IP Advanced Engineering
Addressing Media
Association Method By Source IP address w Allow Empty INVITE |
Send Empty re-INVITE |
Call Routing Method To Head ~
a7 fouting ° o Tieader Allow To Tag Change |
Suppress DNS SRV Lockups O P-Early-Media Support Mone >
Send SilenceSupp=0ff |
Identity
Use "phone-context” ( Media Connection Disabled -
Add user=phone O Preservation
Use + for International O Indicate HOLD |
Use PAl for Privacy |
Usze Domain for PAI O Call Control
S Fi d PAl/Diversi =
wap From and PAl/Diversion L] Call Initiation Timeout (s) 4 z
Caller ID from From header |
Send From In Clear O Call Queuing Timeout (mins) 5 =
Cache Auth Credentials Service Busy Response 486 - Busy Here ~
User-Agent and Server Headers l:l on Mo User Responding Send | 408-Request Timeout ~
send Location Info picves e Action on CAC Location Limit | Allow Voicemail ~
Suppress .850 Reason O
Header
Emulate NOTIFY for REFER 1]
Mo REFER if using Diversion [
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5.5. Alternate Route Selection (ARS)

Alternate Route Selection (ARS) is used to route outbound traffic to the SIP line. To define a
new ARS route, right-click ARS in the Navigation pane and select New. In the Details pane that

appears, a collection of matching patterns (similar to short codes) can be entered to route calls as
shown below.

For the compliance test, two entries were created. The first entry matches on 0 and the second
entry matches on any other number N.

To create an entry, click the Add button and enter the following in the pop-up window (not
shown).

e Inthe Code field, enter the pattern to match the number passed to ARS from the short
code in Section 5.6. The value N; will match any number.

e Set Feature to Dial. This is the action that the entry will perform.

e For Code 0, set Telephone Number to 0”@ipaddr”, where ipaddr is the IP address of
the internal interface of the Avaya SBCE and used to configure the trunk in Section
5.4.3. Adding the IP address in this field was required to ensure that the correct Request-
URI header appears in the outbound INVITE when dialing 0. This was not required
when matching on any other dialed number as shown next.

e For Code N;, set Telephone Number to N. This field is used to construct the Request-
URI and To headers in the outgoing SIP INVITE message. The value N represents the
complete number passed to ARS.

e Setthe Line Group Id to the outgoing line group number defined on the SIP URI tab on

the SIP Line in Section 5.4.5. This entry will use this line group when placing the
outbound call.

Click the OK button (not shown).

| IPoffices  |i= SP SIP Route ko [ X v <>
- K BOOTP (3) ARS
-4+ Operator (3)
=5 Atlantic City ARS Route |D 51 [] Secondary Dial tone
2 s CR
-9 Line (25 ;
. C”n-I:t(rnI)Unit @ Route Name 5P SIP Route SystemTone
i Extension (25)
+i User (27) Dial Delay Time System Default (4) £ [[] Check User Call Barring
- Group (1)
- 8% Short Code (65)
@ Service (0) Description | |
o-all; RAS (1)
+® Incoming Call Route
8 WAN Port (0) In Service Out of Service Route <Mone> =
a4 Directory (0) l
£70 Time Profile (0)
+@ Firewall Prefile (1) Time Profile <Nonex» —— (Ut of Hours Route <Mone> =
- ill IP Route (4)
-~ Account Code (0) l
e License (104)
Tunnel (0) Code Telephone Mumber Feature Line Group ID Add...
i-fq User Rights (8) ]
- 0 0"@10.32.128.20" Dial 17
IE?; Location (0) N; N Dial 7 femove
- i4% Authorization Code
ﬂ Edit...
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5.6. Short Codes

A short code is a dial pattern that triggers a specific function. A short code is used by the caller
to route outbound traffic to ARS. To create a short code, right-click on Short Code in the
Navigation Pane and select New, (not shown). On the Short Code tab in the Details Pane,
configure the parameters as shown below.

¢ Inthe Code field, enter the dial string which will trigger this short code, followed by a
semi-colon. In this case, 9N;. This short code will be invoked when the user dials 9
followed by any number.

e Set Feature to Dial. This is the action that the short code will perform.

e Set Telephone Number to N. The value N represents the number dialed by the user after
removing the 9 prefix. This value is passed to ARS.

e Setthe Line Group ID to the ARS route to be used (Section 5.5).

Click the OK button (not shown).

IP Offices | E 9N;: Dial S -
+a BOOTP (3) Short Code |
'f""‘.'" Operator [E)]

%5 Atlantic City Code o |
-39 System (1)
517 Line (25) Feature Dial -
+ = Control Unit (3]
+$ Extension (25) Telephone Number |N |
+: User (27) i
- 51: 5P SIP Rout >
-4 Group (1) Line Group 1D | o |
+';¢ Short Code (65) Locale =
@ Service (0]
+“% RAS (1) Force Account Code O
+® Incoming Call Route (7| po -0 aithorization Code [
ﬁj‘! WAN Port (0}
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Optionally, add or edit a short code that can be used to access the SIP Line anonymously. In the
screen shown below, the short code *67N; is illustrated. This short code is similar to the 9N;
short code except that the Telephone Number field begins with the letter W, which means
“withhold the outgoing calling line identification”.

In the case of the SIP Line documented in these Application Notes, when a user dials *67 plus
the number, Avaya IP Office will include the calling number in the P-Asserted-Identity (PAI)
header and will include the Privacy: Id header.

B

IP Offices = *67N;: Dial X/l wv|<]|>
=& BOOTP (3) Short Code
% Operator (3]
Atlantic City Code "ETN; |
t-2) System (1)
-7 Line (25) Feature Dial e
[ Contrel Unit (3)
@ Extension (25) Telephone Mumnber |WN |
@ User (27) . : »
38 Group (1) Line Group ID |51: P SIP Route |
B ot Coue (o> [N (Y 5
4B Service (0)
n%; RAS (1) Force Account Code O
@ Incaming Call Route (7| £5 1 Athorization Code [
- ¥g WAN Port (0)
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5.7. User

If the SIP Line is configured to use Internal Data in Section 5.4.5, then configure the SIP
parameters for each user that will be placing and receiving calls via the SIP line. To configure
these settings, first navigate to User - Name in the Navigation Pane where Name is the name of
the user to be modified. In the example below, the name of the user is Extn243. Select the SIP
tab in the Details Pane. The values entered for the SIP Name and Contact fields are used as the
user part of the SIP URI in the From and Contact headers for outgoing SIP trunk calls and allow
matching of the SIP URI for incoming calls without having to enter this number as an explicit
SIP URI for the SIP line (Section 5.4.5). The example below shows the settings for user
Extn243. The SIP Name and Contact are set to one of the DID numbers assigned to the
enterprise from Ironton. The SIP Display Name (Alias) parameter can optionally be configured
with a descriptive name. If all calls involving this user and a SIP Line should be considered
private, then the Anonymous box may be checked to withhold the user’s information from the

network.

Click the OK button (not shown).

+ = Control Unit (3)
-4 Extension (25)
o
-3 Group (1)
8% Short Code (55)

+m§,; RAS (1)

SIP Display Name (Alias) ‘Ex‘tnld} |

Contact ‘161 05551235 |

] Anonymous

| IP Offices IE Extn243: 243 - X v<l> @
:'S BOOOTEG(:;] User Voicemail DND Short Codes  Source Mumbers  Telephony Forwarding Dial In - Voice Recording  Button Programming
erator
i:_:-ASanticCit)r Menu Programming  Mobility Group Membership  Announcements  5IP Personal Directory  Web Self-Administration
*;"""":- System (1)
-7, Line (25) SIP Name ‘16105551235 |
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5.8. Incoming Call Route

An incoming call route maps an inbound DID number on a specific line to an internal extension.
This procedure should be repeated for each DID number provided by the service provider. To
create an incoming call route, right-click Incoming Call Routes in the Navigation Pane and

select New.

5.8.1. Incoming Call Route — Standard Tab
On the Standard tab of the Details Pane, enter the parameters as shown below.

e Set the Bearer Capacity to Any Voice.
e Setthe Line Group Id to the incoming line group of the SIP line defined in Section

5.4.5.

e Set the Incoming Number to the incoming number on which this route should match.
e Default values can be used for all other fields.

3

= 17 6105551235

IP Offices :ji - x < | >
'"a BOOTP (3) Standard  Voice Recording Destinations
(# Operator (3)
E1-%5 Atlantic City
-5 System (1) n : .
BT Line (25) Bearer Capability Any Voice
B~ Control Unit (3) Line Group ID 7 v]
-4 Extension (23)
E-§  User (27) Incoming Mumber |6105551235 |
[-5af Group (1) _
[-8% Short Code (65) Incoming Sub Address | |
B Service (0 )
[]...E R;r?ae)( ) Incorning CLI | |
L&Y incoming CallRoute G IR .
B2 WAN Port (0)
- Directory (0] Priority 1- Low v
£ Time Profile (0)
w-@ Firewall Profile (1) Tag | |
(-l 1P Route (4)
-8 Account Code (D) Held Music Scurce Systern Source ~
- Rge License (104) . )
i Tunnel (0) Ring Tone Override |N0ne - |
[rai. . P Dimlnke (07
5.8.2. Incoming Call Route — Destinations Tab
On the Destinations tab, select the destination extension from the pull-down menu of the
Destination field. Click the OK button (not shown). In this example, incoming calls to
6105551235 on line 17 are routed to extension 243.
= 17 6105551235 £ - X <>
Standard Voice Recording Destinations
TimeProfile Destination Fallback Extension
2 Default Yalue 243 Bxtn243 w
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Incoming Call Routes for other direct mappings of DID numbers to Avaya IP Office users listed

in Figure 1 are omitted here, but can be configured in the same fashion.

5.9. Save Configuration

Navigate to File > Save Configuration in the menu bar at the top of the screen to save the

configuration performed in the preceding sections.

The following will appear, with either Merge or Immediate selected, based on the nature of the
configuration changes made since the last save. Note that clicking OK may cause a service

disruption. Click OK to proceed.

Save Configuration

IP Office Settings

Configuration Reboot Mode
® Merge

() Immediate

) When Free

() Timed

Reboot Time

12:01 =

Call Barring

OK

Atlantic City

Cancel

Help
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6. Configure Avaya Session Border Controller for Enterprise

This section describes the configuration of the Avaya SBCE. It is assumed that the initial
installation of the Avaya SBCE has been completed, including the assignment of a management
IP address. The management interface must be provisioned on a different subnet than either the
Avaya SBCE private or public network interfaces (i.e., Al and B1).

On all screens described in this section, it is to be assumed that parameters are left at their default
values unless specified otherwise.

6.1. Access the Management Interface

Use a web browser to access the web interface by entering the URL https://<ip-addr>, where
<ip-addr> is the management IP address assigned during installation. The Avaya SBCE login
page will appear as shown below. Log in with the appropriate credentials.

Q v Q Q Log In
Username: ucsec

Password: [
Log In
SESSiOn Border Controuer This system iz restricted solely to authorized users for legitimate
H buginess purpeses only. The actual or attempted unauthorized access,
for Ente rp rlse use or modifications of this system is strictly prohibited. Unauthorized

users are subject to company disciplinary procedures and or criminal
and civil penalties under state, federal or other applicable domestic and
foreign laws.

The uze of this system may be monitored and recorded for
administrative and security reasons. Anyone accessing this system
expressly conzents to such monitering and recerding, and iz advised
that if it reveals possible evidence of criminal activity, the evidence of
such activity may be provided to law enforcement officials.

All uzers must comply with all corperate instructions regarding the
protection of information assets.

@ 2011 - 2018 Avaya Inc. All rights reserved.
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After logging in, the Dashboard screen will appear as shown below. All configuration screens of
the Avaya SBCE are accessed by navigating the menu tree in the left pane.

Session Border Controller for Enterprise AVAYA

Dashboard Dashboard .

Administration
Information

Installed Devices

Backup/Restore

System Management System Time 02:46:59 PM EDT  Refresh EMS

> Global Parameters Version 7.1.0.0-04-11122 vnj-sbce?
> Global Profiles Build Date Thu Jun 9 20:20:31 EDT

> PPM Services 2016

> Domain Policies License State @ 0K

> TLS Management Aggregate Licensing Overages 0

Device Specific Settings

Peak Licensing Overage Count 0

Last Logged in at 09/12/2016 13:54:38 EDT
Failed Login Attempts 0
Alarms (past 24 hours) Incidents (past 24 hours)
Mone found. None found.
Add | o,
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6.2. Verify Network Configuration and Enable Interfaces

To view the network information provided during installation, navigate to System Management.
In the right pane, click View highlighted below.

Dashboard
Administration
Backup/Restore
System Management
> Global Parameters
> Global Profiles

> PPM Services

> Domain Policies

> TLS Management

> Device Specific Settings

Session Border Controller for Enterprise

System Management

Devices | | Updates | | SSLVPN || Licensing

AVAYA

Device
Name P

ERENETET TS

Version Status

vnj-sbce2  10.32.101.20  7.1.0.0-04-11122 Commissioned

Reboot  Shutdown Restart Application | View

Edit Uninstall

A System Information page will appear showing the information provided during installation.
The Appliance Name field is the name of the device (vnj-sbce2). This name will be referenced
in other configuration screens. Interfaces Al and B1 highlighted below represent the private (or
internal) and public (or external) interfaces of the Avaya SBCE for SIP Trunking. Each of these
interfaces must be enabled after installation. Note that the Management IP is on a different
subnet than either the A1 and B1 interfaces.

Deployment Mode  Proxy

System Information: vnj-sbce2 X

General Configuration Device Configuration r License All

Appliance Name wnj-sbce2 HA Mode Mo Standard Sessions
Requestsd: 0

Box Type SIP Two Bypass Mode Mo

Advanced Sessions
o

r Network Configuration

Scopia Video Sessions
Requested

CES Sessions
Requestsd: 0

Transcoding Sessions
Requested: 0

Encryption

0

0

Public IP Metwork Prefix or Subnet Mask — Gateway Interface

10.32.128.20 10.32.128.20 2552552550 10.32.128 254 Al

10.32.128.21 1032128 21 2552552550 10.32.128 254 Al

192.168.96.233 102.168.96.233 255255256224 192.168.96.254 B1

192.168.96.234 182.168.96.234 255 255 256 224 192.168.96.254 B1

r DNS Configuration g IP(s)

Primary DNS 192.168.132.219 ’V IP #1 {IPvd) 10.32.101.20

Secondary DNS

DNS Location DMZ

DNS Client P 10.32.128.20
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To enable the interfaces, first navigate to Device Specific Settings - Network Management in
the left pane and select the device being managed in the center pane. In the right pane, click on
the Interface Configuration tab. Verify the Administrative Status is Enabled for both the Al
and B1 interfaces. If not, click Toggle to enable the interface.

Dashboard

Administration

~

Session Border Controller for Enterprise AVAYA

Network Management: vnj-sbce2

Backup/Restore ; .
Network Configuration | | Interface Configuration |
System Management 1 !
> Global Parameters vnj-sbee? Administrative Status
> Global Profiles Al Enabled Toggle
» SIP Cluster A2 Disabled Toggle
> Domain Policies
B1 Enabled Toggle
> TLS Management
4 Device Specific Settings
Network
Management
Media Interface
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6.3. Signaling Interface

A signaling interface defines an IP address, protocols and listen ports that the Avaya SBCE can
use for signaling. Create a signaling interface for both the internal and external sides of the
Avaya SBCE.

To create a new interface, navigate to Device Specific Settings = Signaling Interface in the
left pane. In the center pane, select the Avaya SBCE device (vnj-sbce2) to be managed. In the
right pane, select Add. A pop-up window (not shown) will appear requesting the name of the
new interface, followed by series of pop-up windows in which the interface parameters can be
configured. Once complete, the settings are shown in the far right pane.

For the compliance test, signaling interface Int_Sig_Intf was created for the Avaya SBCE
internal interface and signaling interface Ext_Sig_Intf was created for the Avaya SBCE external
interface. These two signaling interfaces are highlighted below. When configuring the
interfaces, configure the parameters as follows:

e Set Name to a descriptive name.

e For the internal interface, set the Signaling IP to the IP address associated with the private
interface (Al) specified in Section 6.2. For the external interface, set the Signaling IP to
the IP address associated with the public interface (B1) specified in Section 6.2.

¢ In the UDP Port, TCP Port and TLS Port fields, enter the port the Avaya SBCE will listen
on for each transport protocol. For both the internal and external interfaces, the Avaya
SBCE was configured to listen for UDP or TCP on port 5060. Since Ironton uses UDP on
port 5060, it would have been sufficient to simply configure the Avaya SBCE external
interface for UDP only.

Session Border Controller for Enterprise AVAYA

Dashboard Signaling Interface: vnj-shce2
Administration

Backup/Restore .
Signaling Interface

System Management
vnj-shce2

> Global Parameters

Modifying or deleting an existing signaling interface will require an application restart before

> Global Profiles taking effect. Application restarts can be issued from System Management.
> PPM Services
> Domain Policies
SignalingIP  TCP LS
» TLS Management Netwark Port Port TEFTiz
i i i 10.32.128.20
# Device Specific Seftings Int_Sig_Intf Mo ool 5060 5060 —  None Edit Delste
Network Management VLAN OF
192.168.96.233
Media Interface Ext_Sig_Intf Network_s1-2 (1. 0060 5060 - None Edit Delete
Signaling Interface VLAN 0}
End Point Flows
Int_Sig_Intf_RW lllgnwgc,zm&?uil 5060 - — None Edit Delete
Session Flows VLAN 0]
> DMZ Services 192.168.96.234
Ext Sig Intf RW  metwork 51-2(81, — — 5061 AvayaSBCServer Edit Delete
TURN/STUN Service VLAN 0)
SNMP
CTM; Reviewed: Solution & Interoperability Test Lab Application Notes 40 of 72

SPOC 11/9/2016 ©2016 Avaya Inc. All Rights Reserved. IronlPO10SBCE71



6.4. Media Interface

A media interface defines an IP address and port range for transmitting media. Create a media
interface for both the internal and external sides of the Avaya SBCE.

To create a new interface, navigate to Device Specific Settings = Media Interface in the left
pane. In the center pane, select the Avaya SBCE device (vnj-sbce2) to be managed. In the right
pane, select Add. A pop-up window (not shown) will appear requesting the name of the new
interface, followed by series of pop-up windows in which the interface parameters can be
configured. Once complete, the settings are shown in the far right pane.

For the compliance test, media interface Int_Media_Intf was created for the Avaya SBCE
internal interface and media interface Ext_Media_Intf was created for the Avaya SBCE external
interface. Each is highlighted below. When configuring the interfaces, configure the parameters
as follows:

e Set Name to a descriptive name.

e For the internal interface, set the Media IP to the IP address associated with the private
interface (A1) specified in Section 6.2. For the external interface, set the Media IP to the IP
address associated with the public interface (B1) specified in Section 6.2.

e Set Port Range to a range of ports acceptable to both the Avaya SBCE and the far end. For
the compliance test, the default port range was used for both interfaces.

Session Border Controller for Enterprise AVAYA

Dashboard
Administration

Media Interface: vnj-sbhce2

Backup/Restore

Media Interface

vnj-sbhce2

System Management
> Global Parameters
» Global Profiles
> PPM Services

> Domain Policies

Medifying or deleting an existing media interface will require an application restart before taking

effect. Application restarts can be issued from System Management.

> TLS Management

End Point Flows
Session Flows
> DMZ Services

Ext_Media_Intf RW

192.168.96.234

Network_51-2 (B1, VLAN 0} 35000 - 40000

4 Device Specific Settings Int_Media_Intf jo3z1820 35000-40000  Edit Delete
Network Management
: 192.168.96.233 ; "
Media Interface Ext_Media_Intf e TR LT 35000 - 40000 Edit Delete
Signaling Interface Int_Media_Intf RW 103242821 = 35000-40000  Edit Delete

Edit

Delete
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6.5. Server Interworking

A server interworking profile defines a set of parameters that aid in interworking between the
Avaya SBCE and a connected server. Create one server interworking profile for Avaya IP
Office and another for the service provider SIP server. These profiles will be applied to the
appropriate servers in Section 6.6.1 and 6.6.2.

To create a new profile, navigate to Global Profiles = Server Interworking in the left pane. In
the center pane, select Add. A pop-up window (not shown) will appear requesting the name of
the new profile, followed by series of pop-up windows in which the profile parameters can be
configured. Once complete, the settings are shown in the far right pane. Alternatively, a new
profile may be created by selecting an existing profile in the center pane and clicking the Clone
button in the right pane. This will create a copy of the selected profile which can then be edited
as needed.

To view the settings of an existing profile, select the profile from the center pane. The settings
will appear in the right pane.

The screen below shows the user interface as described above, before creating the specific server
interworking profiles used for the compliance test.

Session Border Controller for Enterprise AVAYA

Dashboard Interworking Profiles: avaya-ru

Administration
Add Clone

Backup/Restore

Interworking It is not recommended to edit the defaults. Try cloning or adding a new profile instead.

System Management Profiles

> Global Parameters 52100 General || Timers || Privacy || URI Manipulation || Header Manipulation ‘ | Advanced ‘
4 Global Profiles ~
Server Interworking 0CS-Edge-Se.. Hold Support NONE
Media Forking . 180 Handling None
cisco-ccm
Routing 181 Handling Mone
Server Configuration =E
g 182 Handling None
Topology Hiding OCS-FrontEn...
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6.5.1. Server Interworking — Avaya IP Office

The recommended method of creating a server interworking profile for Avaya IP Office is to
first clone the predefined profile avaya-ru and then make any changes necessary to support a
specific service provider. For the compliance test, server interworking profile IPOffice-T38 was
created for Avaya IP Office using this approach and the T.38 Support parameter was set to Yes.
The General tab parameters are shown below.

General || Timers || Privacy | | URI Manipulation | | Header Manipulation | | Advanced
'
Hold Support MOME
180 Handling MNone
181 Handling MNone
182 Handling MNone
183 Handling MNone
Refer Handling Mo
URI Group MNone
Send Hold Mo
Delayed Offer Mo 3
3¢ Handling Mo
Diversion Header Support Mo
Delayed SDP Handling Mo
Re-Invite Handling Mo
Prack Handling Mo
Allow 18X SDP Mo
T.38 Support Yes
URI Scheme SIP
Via Header Format RFC3261 T

The Timers, URI Manipulation and Header Manipulation tabs use default values.
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The Advanced tab parameters are shown below. Highlighted values below indicate differences
between the cloned profile and the default value.

General | | Timers | | Privacy || URI Manipulation | | Header Manipulation | | Advanced |_
Record Routes Both Sides
Include End Paint IP for Context Lookup  Yes
Extensions Avaya
Diversion Manipulation Mo
Has Remaote SBC Yes
Route Response on Via Port Mo
Relay INVITE Replace for SIPREC Mo
DTMF
OTMF Support Mone
Edit
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6.5.2. Server Interworking - lronton

For the compliance test, server interworking profile SP-General-T38 was created for the Ironton
SIP server. When creating the profile, the default values were used for all parameters except that
the T.38 Support parameter was set to Yes. The General tab parameters are shown below.

General || Timers | | Privacy | | URI Manipulation | | Header Manipulation | | Advanced
Hold Support NOMNE
180 Handling Mone
181 Handling MNone
182 Handling Mone
183 Handling MNone
Refer Handling Mo
LRI Group MNone
Send Hold Mo
Delayed Offer Mo -
3¢ Handling Mo
Diversion Header Support Mo
Delayed SOP Handling Mo
Re-lnvite Handling Mo
Prack Handling Mo
Allow 18X SDP Ma
T.386 Support Yes
LRl Schame SIP
Via Header Format RFC3261 M

The Timers, URI Manipulation and Header Manipulation tabs use default values.
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The Advanced tab parameters are shown below.

General | | Timers

Privacy | | URl Manipulation

Header Manipulation

Record Routes

DTMF Support

Include End Point IP for Context Lookup Mo

Extensions Mone
Diversion Manipulation Mo
Has Remote SBC Yes
Route Response on Via Port Mo
Relay INVITE Replace for SIPREC Mo

Mone

Edit

OTMFE
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6.6. Server Configuration

A server configuration profile defines the attributes of the physical server. Create one server
configuration profile for Avaya IP Office and another for the service provider SIP server.

To create a new profile, navigate to Global Profiles = Server Configuration in the left pane.
In the center pane, select Add. A pop-up window (not shown) will appear requesting the name
of the new profile, followed by series of pop-up windows in which the profile parameters can be
configured. Once complete, the profile name will appear under Server Profiles in the center
pane and the settings are shown in the far right pane.

To view the settings of an existing profile, select the profile from the center pane. The settings
will appear in the right pane.

Session Border Controller for Enterprise AVAYA
Dashboard Server Configuration: IPO-ACity
Administration Add [ Rename H Clone ” Delete ]
Backup/Restore
General | | Authentication | | Heartbeat | | Advanced |

System Management
» Global Parameters IPO-ACity Server Type Call Server
4 Global Profiles

Domain DoS IP Address / FQDN Transport

Server Interworking 10.32.128.25 5060 UDP

Media Forking 10.32.128.25 5060 TCP

Routing

Edit
Server Configuration
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6.6.1. Serve

r Configuration — Avaya IP Office

For the compliance test, the server configuration profile IPO-ACity was created for Avaya IP
Office. When creating the profile, configure the General tab parameters as follows:

e Set Server Type to Call Server.

e Set IP Address / FQDN to the Avaya IP Office LAN1 address (Section 5.2.1).

e Enter a valid combination of Port and Transport that Avaya IP Office will use to listen for
SIP requests. The standard SIP UDP/TCP port is 5060. Additional combinations can be
entered by clicking the Add button (not shown).

General | | Authentication | | Heartbeat | | Advanced
Server Type Call Server
IP Address f FQDN Transport
10.32.128.25 5060 LUDP
10.32.128.25 5060 TCP

The Authentication and Heartbeat tabs use the default values.

On the Advanced tab, set the Interworking Profile field to the interworking profile for Avaya

IP Office defined in Section 6.5.1.
General | | Authentication | | Heartbeat | | Advanced

Enable DoS Protection ]

Enable Grooming ]

Interworking Profile IPOffice-T38
Signaling Manipulation Script Mone

Securable |

Enable FGDN ]

Edit
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6.6.2. Server Configuration — Ironton

For the compliance test, the server configuration profile Ironton was created for the Ironton SIP
Server. When creating the profile, configure the General tab parameters as follows:

e Set Server Type to

Trunk Server.

e Set IP Address / FQDN to the Ironton SIP proxy IP address provided by Ironton.
e Enter a valid combination of Port and Transport that the Ironton SIP proxy will use to
listen for SIP requests. Additional combinations can be entered by clicking the Add button

(not shown).

General | | Authentication Heartbeat | | Advanced

Server Type

IP Address / FQDOM

192.168.16.94

Trunk Server

5060

Edit

Transport

UDP

The Authentication and Heartbeat tabs use the default values.

On the Advanced tab, set the Interworking Profile field to the interworking profile for Ironton

defined in Section 6.5.2

General | | Authentication Heartbeat | | Advanced

Enable Grooming

Interworking Profile

Enable DoS Protection ]

[

SP-General-T38

Signaling Manipulation Script Mone
Securable ]
Enable FGDN ]

Edit
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6.7. Application Rules

An application rule defines the allowable SIP applications and associated parameters. An
application rule is one component of the larger endpoint policy group defined in Section 6.10.

To create a new profile, navigate to Domain Policies = Application Rules in the left pane. In
the center pane, select Add. A pop-up window (not shown) will appear requesting the name of
the new profile, followed by series of pop-up windows in which the profile parameters can be
configured. Once complete, the settings are shown in the far right pane. Alternatively, a new
profile may be created by selecting an existing profile in the center pane and clicking the Clone
button in the right pane. This will create a copy of the selected profile which can then be edited
as needed.

To view the settings of an existing profile, select the profile from the center pane. The settings
will appear in the right pane.

For the compliance test, the application rules profile named low-AudioSessions was cloned from
the default-trunk profile in which the settings for both Maximum Concurrent Sessions and
Maximum Sessions Per Endpoint were adjusted down to 500 (from 2000) for Audio. This
change was to accommodate the maximum capacity on the Avaya SBCE running on the Portwell
CAD-0208 server. The low-AudioSessions application rules profile was used for both Avaya IP
Office and the Ironton SIP server.

Session Border Controller for Enterprise AVAYA
Dashboard A~ Application Rules: low-AudioSessions
Administration Add |Filter By Device. .. V| | Rename || Clone || Delete |
Backup/Restore —
Application Rules Click here to add a description.
System Management
default
> Global Parameters Application Rule
. default-trunk
Global Profiles Application Ty In  Out Maximum Concurrent Maximum Sessions Per
> PPM Services default-subscrib. .. P ype Sessions Endpoint
4 Domain Policies default-subscrib Audio M [ 500 500
Application Rules
default-server-low Video o O
Border Rules
Media Rules default-server-h... M O o
Security Rules AppRule_RW
-,
Signaling Rules low-AudioSes... COR S N
" rt
Time of Day Rules Hppo one
End Point Policy RTCP Keep-Alive No
Groups
-Edit
Session Policies
> TLS Management
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6.8. Media Rules

A media rule defines the processing to be applied to the selected media. A media rule is one
component of the larger end point policy group defined in Section 6.10. For the compliance test,
the predefined default-low-med media rule (shown below) was used for both Avaya IP Office
and the Ironton SIP server.

To view an existing rule, navigate to Domain Policies - Media Rules in the left pane. In the
center pane, select the rule (e.g., default-low-med) to be viewed.

Each of the tabs of the default-low-med media rule is shown below.

The Media Encryption tab shows the Preferred Formats field for both Audio Encryption and
Video Encryption is set to RTP (as opposed to SRTP) indicating that no encryption was used.

Session Border Controller for Enterprise AVAYA
Dashboard Media Rules: default-low-med
Administration -
Add | Filter By Device... v| Clone
Backup/Restore
System Management
» Global Parameters default-low-med Encryption | | Codec Prioritization | | Advanced | | QoS |
» Global Profiles default-low-med-enc . .
default-high

4 Domain Policies Preferred Formats RTP

Application Rules default-high-enc Interworking

Border Rules avaya-low-med-enc

Media Rules SRTP_RW

Security Rules Preferred Formats RTP

. : RTP_RW

Signaling Rules Interworking

End Point Policy

Groups Miscellaneous

Session Policies ] ]
- TLS Management Capability Megotiation O
> Device Specific Settings Edit
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The Codec Prioritization tab settings are shown below.

Encryption | | Codec Prioritization | | Advanced | | Qo5

Audio Codec

Codec Prioritization ]

Video Codec

Codec Prioritization ]

Edit

The Advanced tab shows all advanced features are disabled.

Encryption | | Codec Prioritization | | Advanced || Qo5

Silencing Enabled ]

Silencing

Binary Floor Control Protocol

BFCF Enabled ]

Far End Camera Control

FECC Enabled ]
AMNAT
AMNAT Enabled ]
Edit
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The QoS settings used for the compliance test are shown below. These QoS settings are not a
requirement for interoperability and QoS was not tested as part of the compliance test. If the
QoS settings shown here do not meet the needs of the customer then the media rule should be
cloned and set as per customer requirements.

Encryption || Codec Prioritization | | Advanced || QoS

Media QoS Marking

Enabled
Qo5 Type DSCP
Audio DSCP EF
Video DSCP EF
Edit
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6.9. Signaling Rules

A signaling rule defines the processing to be applied to the selected signaling traffic. A signaling
rule is one component of the larger end point policy group defined in Section 6.10. Separate
signaling rules were used for Avaya IP Office and the Ironton SIP server.

To create a new profile, navigate to Domain Policies = Signaling Rules in the left pane. In the
center pane, select Add. A pop-up window (not shown) will appear requesting the name of the
new profile, followed by series of pop-up windows in which the profile parameters can be
configured. Once complete, the settings are shown in the far right pane.

To view an existing rule, navigate to Domain Policies = Signaling Rules in the left pane. In
the center pane, select the rule (e.g., default) to be viewed.

Dashboard
Administration
Backup/Restore

Session Border Controller for Enterprise AVAYA

Signaling Rules: default

Add Filter By Device... -

Systern Management Signaling Rules It is not recommended to edit the defaults. Try cloning or adding a new rule instead.
> Global Parameters Qe General | Req H Resp || Request Head || Response Head Signaling QoS || UCID|
> Global Profiles Mo-Content-Type
> PPM Services
4 Domain Policies Requests Allow
Application Rules Non-2XX Final Responses Allow
Border Rules SnPrvder-SR Optional Request Headers Allow
Mediz Rules Optional Response Headers Allow
Security Rules
Signaling Rules
End Point Policy Requests Allow
Groups
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6.9.1. Signaling Rule — Avaya IP Office

For the compliance test, the predefined default signaling rule was used for Avaya IP Office. The
General tab settings of the default signaling rule are shown below.

General | | Requests || Responses | | Request Headers | | Response Headers | | Signaling QoS || UCID

Requests Allow
Mon-2X¥X Final Responses Allow
Optional Request Headers Allow
Optional Response Headers Allow

Requests Allow
Mon-2¥X Final Responses Allow
Optional Request Headers Allow
Optional Response Headers Allow

Content-Type Policy

Enable Content-Type Checks
Action Allow Multipart Action Allow
Exception List Exception List

The Requests, Responses, Request Headers, and Response Headers tabs have no entries.
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The Signaling QoS settings used for the compliance test are shown below. These QoS settings
are not a requirement for interoperability and QoS was not tested as part of the compliance test.
If the QoS settings shown here do not meet the needs of the customer then the signaling rule

should be cloned and set as per customer requirements.

General l | Requests | ‘ Responses \ | Request Headers , | Response Headers I Signaling QoS ] | ucip |

Signaling QoS I
QoS Type DSCP
DSCP AF41

The UCID setting is shown below.

General || Requests | | Responses | | Request Headers | | Response Headers

Signaling QoS | | UCID

UCID [
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6.9.2. Signaling Rules — Ironton

For the compliance test, the SrvPrvder-SR signaling rule was used for Ironton. The signaling
rule was created using all default values with the exception of the QoS settings. The General tab
settings are shown below.

General | | Requests || Responses | | Request Headers | | Response Headers | | Signaling Qo5 || UCID

Requests Allow
Mon-2X¥X Final Responses Allow
Optional Request Headers Allow
Optional Response Headers Allow

Requests Allow
Mon-2¥¥ Final Responses Allow
Optional Request Headers Allow
Optional Response Headers Allow

Content-Type Policy

Enable Content-Type Checks
Action Allow Multipart Action Allow
Exception List Exception List

The Requests, Responses, Request Headers, and Response Headers tabs have no entries.
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The Signaling QoS tab is shown below. These QoS settings are not a requirement for
interoperability and QoS was not tested as part of the compliance test. If the QoS settings shown

here do not meet the needs of the customer then the signaling rule should be set as per customer
requirements.

General | | Requests | | Responses | | Request Headers | | Response Headers | | Signaling QoS || UCID

Signaling QoS
QoS Type DSCP
DSCP EF

The UCID setting is shown below.

General || Requests | | Responses | | Request Headers | | Response Headers | | Signaling QoS | | UCID

UcCID O
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6.10. End Point Policy Groups

An end point policy group is a set of policies that will be applied to traffic between the Avaya
SBCE and a signaling endpoint (connected server). Thus, one end point policy group must be
created for Avaya IP Office and another for the service provider SIP server. The end point
policy group is applied to the traffic as part of the end point flow defined in Section 6.13.

To create a new group, navigate to Domain Policies > End Point Policy Groups in the left
pane. In the center pane, select Add. A pop-up window (not shown) will appear requesting the
name of the new group, followed by series of pop-up windows in which the group parameters
can be configured. Once complete, the settings are shown in the far right pane. To view the
settings of an existing group, select the group from the center pane. The settings will appear in
the right pane.

Session Border Controller for Enterprise AVAYA
Dashboard Policy Groups: default-low
Administration |Fi\terEy Device... V|
Backup/Restore
Policy Groups is e ended to edit the defaults. e stead.
System Management It is not recommended to edit the defaults. Try adding a new group instead
i default-low
> Global Profiles default-low-enc
Policy Group
> SIP Cluster default-med
4 Domain Policies S Add
o default-med-enc
Application Rules . Order  Application Border Media Security Signaling  Time of Day
Border Rules eI - defaultdow
. -1 default default Y defaultdlow  default default Edit Clone
Media Rules default-high-enc -med
Security Rules

OCS-default-high
Signaling Rules

. -def-low-g...
Time of Day Rules Fvays-dstions

End Point Policy
Groups

6.10.1. End Point Policy Group — Avaya IP Office

For the compliance test, the end point policy group IPO-EP-Policy was created for Avaya IP
Office. Default values were used for each of the rules which comprise the group with the
exception of Application. For Application, enter the application rule specified in Section 6.7.
The details of the default settings for Media and Signaling are shown in Section 6.8 and Section
6.9.1 respectively.

Policy Group

Order Application Border Media Security Signaling
1 low-AudioSessions  default default-low-med  default-low default Edit
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6.10.2. End Point Policy Group — Ironton

For the compliance test, the end point policy group SP-EP-Policy was created for the Ironton
SIP server. Default values were used for each of the rules which comprise the group with the
exception of Application and Signaling. For Application, enter the application rule specified in
Section 6.7. For Signaling, enter the signaling rule specified in Section 6.9.2. The details of the
default settings for Media are shown in Section 6.8.

Policy Group

Order

Application

1 low-AudioSessions

Border

default

Media

default-low-med

Security

default-low

Signaling

SnPrider-3R Edit

6.11. Routing

A routing profile defines where traffic will be directed based on the contents of the URI. A
routing profile is applied only after the traffic has matched an endpoint server flow defined in
Section 6.13. Create one routing profile for Avaya IP Office and another for the service provider

SIP server.

To create a new profile, navigate to Global Profiles - Routing in the left pane. In the center
pane, select Add. A pop-up window (not shown) will appear requesting the name of the new
profile, followed by series of pop-up windows in which the profile parameters can be configured.
Once complete, the settings are shown in the far right pane. To view the settings of an existing
profile, select the profile from the center pane. The settings will appear in the right pane.

Dashboard
Administration
Backup/Restore

4 Global Profiles

Domain DoS

Media Forking

System Management

> Global Parameters

Server Interworking

Session Border Controller for Enterprise

Routing Profiles: To-IPO-ACity

Routing Profiles

default
To-IPO-ACity
To-IPO-JCity

To-Trunks

Add

Routing Profile

Click here to add a description.

AVAYA

Rename ][ Clone ][ Delete ]

URI
Group

Priority

Time of Day  Load Balancing

Next Hop Address

Transport

Add

Routing 1 * default Priority 10.32.128.25 UpP Edit Delete
Server Configuration To-SP
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6.11.1. Routing - Avaya IP Office

For the compliance test, the routing profile To-1PO-ACity was created for Avaya IP Office.
When creating the profile, configure the parameters as follows:

e Set the URI Group to the wild card * to match on any URI.
e Set Load Balancing to Priority from the pull-down menu.
e Enable Next Hop Priority.

e Click Add to enter the following for the Next Hop Address:

o Set Priority/Weight to 1.

o For Server Configuration, select IPO-ACity (Section 6.6.1) from the pull-down
menu. The Next Hop Address pull-down menu will show each entry of
Address/Port/Transport defined in the Server Configuration selected. For the
Next Hop Address, select the entry that represents the connection between Avaya
IP Office and the Avaya SBCE. In this case, the connection used UDP on port
5060.

Click Finish.

Profile : To-IPO-ACity - Edit Rule

URI Group Time of Day
Load Balancing | Priority | NAPTR
Transport None MNext Hop Priority
Mext Hop In-Dialog | Ignore Route Header |
ENUM O ENUM Suffix
Add

Priority / Weight ~ Server Configuration Next Hop Address Transport

1 | [ro-acy | [10.32.128.25:5060 (UDP) ~| | none Delete

Finish
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6.11.2. Routing — Ironton

For the compliance test, the routing profile To-Trunks was created for Ironton. When creating
the profile, configure the parameters as follows:

e Set the URI Group to the wild card * to match on any URI.
e Set Load Balancing to Priority from the pull-down menu.
e Click Add to enter the following for the Next Hop Address:

o Set Priority/Weight to 1.

o For Server Configuration, select Ironton (Section 6.6.2) from the pull-down
menu. The Next Hop Address pull-down menu will show each entry of
Address/Port/Transport defined in the Server Configuration selected. For the
Next Hop Address, select the entry that represents the connection between
Ironton and the Avaya SBCE. This connection used UDP on port 5060.

Click Finish.
Profile : To-Trunks - Edit Rule X
R Group Time of Day
Load Balancing | Priority v| NAPTR
Transport None MNext Hop Priarity
Mext Hop In-Dialog ] Ignore Route Header ]
ENUM ] ENUM Suffix
Add
Priority / Weight ~ Server Configuration Next Hop Address Transport
1 | |Iruntnn V| | 192,168.16.94:5060 (UDP) w None Delete
Finish
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6.12. Topology Hiding

Topology hiding allows the host part of some SIP message headers to be modified in order to
prevent private network information from being propagated to the untrusted public network. It
can also be used as an interoperability tool to adapt the host portion of these same headers to
meet the requirements of the connected servers. The topology hiding profile is applied as part of
the end point flow in Section 6.13. For the compliance test, the predefined default topology
hiding profile (shown below) was used for both Avaya IP Office and the Ironton SIP server.

To add a new profile or view an existing profile, navigate to Global Profiles - Topology
Hiding in the left pane. In the center pane, select Add to add a new profile, or select an existing

profile (e.g., default) to be viewed.

Dashboard

Administration

Backup/Restore

System Management

» Global Parameters

4 Global Profiles
Domain DoS
Server Interworking
Media Forking
Routing
Server Configuration
Topology Hiding
Signaling Manipulation
URI Groups
SNMP Traps
Time of Day Rules

> PPM Services

» Domain Policies

Session Border Controller for Enterprise

Topology Hiding Profiles: default

Add

Topology Hiding

Profiles

default

cisco_th_profile

AVAYA

Itis not recommended to edit the defaults. Try cloning or adding a new profile instead.
Topology Hiding

Header Criteria Replace Action Overwrite Value

Record-Route IP/Domain Auto

To |P/Domain Auto —

SDP |P/Domain Auto

Refer-To |P/Domain Auto =

Referred-By IP/Domain Auto

Via |P/Domain Auto —

From |P/Domain Auto

Request-Line IP/Domain Auto —
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6.13. End Point Flows

Endpoint flows are used to determine the signaling endpoints (connected servers) involved in a
call in order to apply the appropriate policies. When a packet arrives at the Avaya SBCE, the
content of the packet (IP addresses, URISs, etc.) is used to determine which flow it matches.

Once the flow is determined, the flow points to policies and profiles which control processing,
privileges, authentication, routing, etc. Once routing is applied and the destination endpoint is
determined, the policies for the destination endpoint are applied. Thus, two flows are involved in
every call: the source end point flow and the destination end point flow. In the case of the
compliance test, the signaling endpoints are Avaya IP Office and the service provider SIP server.

To create a new flow for a server endpoint, navigate to Device Specific Settings - End Point
Flows in the left pane. In the center pane, select the Avaya SBCE device to be managed. In the
right pane, select the Server Flows tab and click the Add button. A pop-up window (not shown)
will appear requesting the name of the new flow and the flow parameters. Once complete, the
settings are shown in the far right pane.

Session Border Controller for Enterprise AVAYA

Dashboard End Point Flows: vnj-sbce2
Administration

Backup/Restore

System Management 4“5"hsc"ber flgus,| | Server Flows

> Global Parameters vnj-shce2 r Server Configuration: IPO-ACity
> Global Profiles Update
> PPM Services
] o Bri Flow N URI Received Signaling Enld R Routing
> Domain Policies LI oW ame Group Interface Interface Gmcy Profile
roup
> TLS Management
4+ Device Specific Setfings IPO-ACity . Ext_Sig_Intf Int_Sig_Intf 'FF,'UCIJ";F" ToTrunks  View
Network Management
2 IPO-ACity-RW  * Ext_Sig_Intf RW Int_Sig_Intf RW RTP-EP-RW default RW  View
Media Interface y i i -
Signaling Interface
) Server Configuration: IPO-JCity
End Point Flows [

6.13.1. End Point Flow — Avaya IP Office

For the compliance test, the end point flow IPO-ACity was created for Avaya IP Office. All
traffic from Avaya IP Office will match this flow as the source flow and use the specified routing
profile To-Trunks to determine the destination server and corresponding destination flow. The
End Point Policy and Topology Hiding Profile will be applied as appropriate. When creating
the flow, configure the parameters as follows:

For the Flow Name, enter a descriptive name.

For Server Configuration, select the Avaya IP Office server created in Section 6.6.1.
To match all traffic, set the URI Group, Transport, and Remote Subnet to *.

Set the Received Interface to the external signaling interface.

Set the Signaling Interface to the internal signaling interface.

Set the Media Interface to the internal media interface.
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e Set the End Point Policy Group to the endpoint policy group defined for Avaya IP
Office in Section 6.10.1.

e Set the Routing Profile to the routing profile defined in Section 6.11.2 used to direct
traffic to the Ironton SIP server.

e Set the Topology Hiding Profile to the topology hiding profile defined for Avaya IP
Office in Section 6.12.

View Flow: IPO-ACity X

- Criteria - Profile
Flow Mame IPO-ACity Signaling Interface Int_Sig_Intf
Server Configuration  IPO-ACity Media Interface Int_Media_Intf
URI Group * Secondary Media Interface MNone
Transport * End Paoint Policy Group IPO-EP-FPaolicy
Remote Subnet * Routing Profile To-Trunks
Received Interface Ext Sig_Intf Topology Hiding Profile default

Signaling Manipulation Script  Mone

Remote Branch Office Any

6.13.2. End Point Flow — Ironton

For the compliance test, the end point flow Ironton-Flow was created for the Ironton SIP server.
All traffic from Ironton will match this flow as the source flow and use the specified routing
profile To-IPO-ACity to determine the destination server and corresponding destination flow.
The End Point Policy and Topology Hiding Profile will be applied as appropriate. When
creating the flow, configure the parameters as follows:

For the Flow Name, enter a descriptive name.

For Server Configuration, select the Ironton SIP server created in Section 6.6.2.

To match all traffic, set the URI Group, Transport, and Remote Subnet to *.

Set the Received Interface to the internal signaling interface.

Set the Signaling Interface to the external signaling interface.

Set the Media Interface to the external media interface.

Set the End Point Policy Group to the endpoint policy group defined for Ironton in

Section 6.10.2.

e Set the Routing Profile to the routing profile defined in Section 6.11.1 used to direct
traffic to Avaya IP Office.

e Setthe Topology Hiding Profile to the topology hiding profile defined for Ironton in

Section 6.12.
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View Flow: Ironton-Flow X

- Criteria - Profile
Flow Mame Ironton-Flow Signaling Interface Ext Sig_Intf
Server Configuration  Ironton Media Interface Ext Media_Intf
URI Group * Secondary Media Interface Mone
Transport * End Point Policy Group SP-EP-Policy
Remote Subnet * Routing Profile To-IPO-ACity
Received Interface Int_Sig_Intf Topology Hiding Profile default

Signaling Manipulation Script  Mone

Remote Branch Office Any
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7. Ironton SIP Trunking Service Configuration

Ironton is responsible for the configuration of the Ironton SIP Trunking Service. The customer
will need to provide the IP address used to reach the Avaya IP Office at the enterprise. In the
case of the compliance test, this is the public IP address of the Avaya SBCE. Ironton will
provide the customer the necessary information to configure Avaya IP Office and the Avaya
SBCE including:

Ironton SIP proxy IP address

Transport protocol and port

SIP Credentials: User name and password
DID numbers

In addition, to configure any possible firewall/security devices at the enterprise, Ironton will
provide the IP address and port of any media sources that will need access to the enterprise.

8. Verification Steps

This section provides verification steps that may be performed in the field to verify that the
solution is configured properly.

8.1. Avaya IP Office

Avaya IP Office has several tools that can be used to verify and troubleshoot the system
operation. Two of these tools are described in the following subsections.

8.1.1. System Status

The System Status application is used to monitor and troubleshoot Avaya IP Office. Use the
System Status application to verify the state of the SIP trunk. System Status can be accessed
from Start = All Programs - IP Office - System Status.

The following screen shows an example Logon screen. Enter the Avaya IP Office IP address in
the Control Unit IP Address field, and enter an appropriate User Name and Password. Click
Logon.

I Avaya IP Office System Status — O x

AVAYA IP Office System Status

Help Exit About
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Select the SIP line under Trunks from the left pane. On the Status tab in the right pane, verify
the Current State is Idle for each channel.

SIP Device

Status  Utilization Summary

Line Service State:

Peer Domain Name:

Resolved Address:

Line Mumber:

Number of Administered Channels:
Number of Channels in Use:
Administered Compression:

Enable Faststart:

Silence Suppression:

Media Stream:

Layer 4 Protocol:

SIP Trunk Channel Licenses:

SIP Trunk Channel Licenses in Use:

Features:

Current Time in Remote Co Conn... Caller ID Other Party Directi... Round R
State  Media... or... onCal Jitter

Ide |[23:29...

IP Office System Status

Alarms  Registration

SIP Trunk Summary

In Service
10.32.128.20
10,32,123.20
17

10

1]

G711Mu, G711 A, G729 A, G7231, G722
Off

off

RTP

uppP

= @
0

REFER (Incoming and Outgoing)

Ide |23:30...

Ide [23:30..,

Ide |23:30...

Ide |23:30...

Ide [23:30..,

Ide |[23:30...

Trace

Save As...

Trace Al Pause

Fing Call Details Graceful Shutdown Force Out of Service Print...

Select the Alarms tab and verify that no alarms are active on the SIP line.

Status  Utilization Summary

Last Date Of Error

Alarms  Registration

Alarms for Line: 17 SIP 10.32.128.20

Occurrences

Error Description
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8.1.2. Monitor

The Monitor application can also be used to monitor and troubleshoot Avaya IP Office. Monitor
can be accessed from Start > All Programs - IP Office - Monitor. The application allows
the monitored information to be customized. To customize, select Filters = Trace Options.

The following screen shows the SIP tab, allowing configuration of SIP monitoring.

CTM; Reviewed:
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All Settings *
T1 | PN | WM | SON | Jade
&M | cal | DTE | ECont | FiameRelay | GOD | H.323 | Interface
ISOM | Kep/Lamp | Diectory | Media | FFF | B2 | Fouting | Services  SIP lSystem]
Events
¥ Sip |Standard - [# STUN [~ SIP Dect
Packets
[ SIF Reg /Opt Rx [ SIP Mizc Ax
[~ SIF RegOpt Tx [ SIP Mizc Tx
[~ SIF Call R= [~ Crn Motify Fi=
[~ SIPCall T [~ Crn Matify T=
[v SipFRx IP Filter [man. nnn.anm. sien)
WV SipTx |
Default AII| Clear Al | Tab I:Iear.-’-‘«||| Tab Set A||| CECT] cancel
Save File | Load File | Load Partial File‘ Select File ‘
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8.2. Avaya Session Border Controller for Enterprise

There are several links and menus located on the taskbar at the top of the screen of the web
interface that can provide useful diagnostic or troubleshooting information.

e Alarms: This option provides information about active alarms.

e Incidents: This option provides detailed reports of anomalies, errors, policies violations,
etc.

e Status: This option provides statistical and current status information.

e Diagnostics: This option provides a variety of tools to test and troubleshoot the Avaya
SBCE network connectivity.

Alarms  Incidents  Status~ Logs~  Diagnostics Users Settings v Help~ Log Out

Session Border Controller for Enterprise AVAYA

9. Conclusion

These Application Notes describe the configuration necessary to connect Avaya IP Office 10.0
and Avaya Session Border Controller for Enterprise 7.1 to the Ironton SIP Trunking Service.
The Ironton SIP Trunking Service is a SIP-based Voice over IP solution for customers ranging
from small businesses to large enterprises. It provides a flexible, cost-saving alternative to
traditional hardwired telephony trunks. The Ironton SIP Trunking Service passed compliance
testing. Please refer to Section 2.2 for any observations/exceptions.
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10. Additional References

This section references documentation relevant to these Application Notes. In general, Avaya
product documentation is available at http://support.avaya.com.

[1] Deploying Avaya IP Office Platform IP500 V2, Document Number 15-601042, Issue 319,
August 3, 2016.

[2] Administering Avaya IP Office Platform with Manager, Release 10, September 2016.

[3] Using System Status, Document Number 15-601758, Issue 11e, July 7, 2016.

[4] Administering Avaya IP Office Voicemail Pro, Document Number 15-601063, Issue 11e,
July 20, 2016.

[5] Using IP Office System Monitor, Document Number 15-601019, Issue 07b, June 9, 2016.

[6] Deploying Avaya Session Border Controller for Enterprise, Release 7.1, Issue 1, June 2016.

[7] Administering Avaya Session Border Controller for Enterprise, Release 7.1, Issue 1, June
2016.

Additional Avaya IP Office documentation can be found at:
http://marketingtools.avaya.com/knowledgebase/
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